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Limitation of liability 

  

PANLAB does not accept responsibility, under any circumstances, for any harm 
or damage caused directly or indirectly by the incorrect interpretation of what 
is expressed in the pages of this manual. 

Some symbols may have more than one interpretation by professionals 
unaccustomed to their usage. 

PANLAB reserves the right to modify, in part or in total, the contents of this 
document without notice. 
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1. INTRODUCTION 

RECORD-IT! MEDIA is a Panlab product specifically designed to record digital 
videos in laboratories and scientific environments. 

RECORD-IT! MEDIA can simultaneously record the live images of up to 16 cameras 
into independent digital video files. The user can select the quality level of each 
video channel to optimize performance and minimize the hard disk space required. 

RECORD-IT! MEDIA also provides a Player for the visualization of the recorded 
videos. 

Both video recording and video playing can be synchronized with a third-party 
system (contact us for technical information). 

Videos generated by RECORD-IT! MEDIA can be easily integrated with the Panlab 
family of video-tracking products (Smart 3.0 and Smart IO)1. 

Specific hardware and accessories like cameras, camera support, camera lens, 
video cables, hubs, etc. are not included and will need to be purchased separately. 

 

  

 

1 Some specific systems may require the installation of additional video decoder modules to process 
the video files generated by Record-It! Media. Smart only works with videos with <40 fps frame rate. 
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2. INSTALLATION OVERVIEW 

2.1. Requirements 

The minimum computer specifications depend on the number of cameras, the 
specifications of the cameras and quality settings. 

If the RECORD-IT! MEDIA is combined with another application, please also check 
the computer specifications for that application. 

Recommended computer specifications needed to use RECORD-IT! MEDIA with up 
to 16 cameras may be found below: 

▪ Intel Core™ i7-10700 (10th gen) processor or superior (Celeron 

processor not supported). 

▪ 16 GB DDR3 RAM or superior. 

▪ 1 TB hard drive or superior (minimum 512 GB). 

▪ C: SSD Drive SATA 2 3GB/s or faster, 250GB or greater. 

▪ D: Drive SATA 3 6GB/s or faster, 500GB or greater. 

▪ Display: 1280 x 720 pixels and 32-bit true color. Screen text size 

must be set at 96 DPI (100%). 

▪ IMPORTANT: Issues may arise if using a computer with VIA 
chipsets in the PC motherboard. It is recommended to use a 
computer without the VIA chipset. 

 

▪ USB ports: 

• One free USB port for the software USB flash key. 

▪ One free PCI Express x4 slot. 

▪ Expansion Hubs USB3 x4 RootHost: 

• Four free USB 3.0 ports are needed for the connection of 4 HUBs 

for 4 USB camera each. 

Operating system supported: 

▪ Microsoft® Windows® 11 64 bits. 

▪ Microsoft Office 64 bits 

 

Network: 

▪ When working with IP Network cameras, the network infrastructure 
(LAN/WAN) and performance of your experimental facilities is an 
important point to be considered. If bandwidth bottlenecks occur, 
streaming video can show jitter, delay, or corruption. This could 
result in the video not getting recorded or showing aberrant 

duration. 
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2.2. Installing the software 

RECORD-IT! MEDIA software is delivered as a single USB flash drive. The USB flash 
drive contains the software installation tool, the User Manual in PDF format, and 
other components required to work in specific conditions. 

Due to security reasons of the Windows® operating system, a user 
with administrative rights is required to install the software and 
other components. Please contact your IT staff before installing the 
software. 

In order to install the software on the PC, follow the next steps: 

▪ Plug the USB flash drive in a free USB port of your computer and wait until 
Windows® installs it as a new removable drive. 

▪ Access the new removable drive detected and execute the PANLAB.EXE file. 
The following window will be shown: 

 

▪ Click on the option Install Record-it! Media v1.0.04. An installation wizard will 
be shown. 

 

▪ Click on the [Next] button to start the software’s installation. 
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▪ Check the I accept the agreement option and click on [Next] button to 
continue. 

 

▪ In the following User Information window introduce the name of the user and 
the company in the correct field. After this, click on [Next] button to continue. 

 

▪ In the following Select Components window check that the option Full 
installation is selected. After this, click on [Next] button to continue. 

▪  
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▪ Select the location where to install the application. By Default, RECORD-IT! 
MEDIA saves the application in C.\Program Files\Panlab\Record-it! Media 
v1.0. After this, click on [Next] button to continue. 

 

▪ In the next Select Components window check that the Full installation option 
is selected. After this, click on [Next] button to continue. 

 

▪ In the following Select Additional Tasks you can check the Create a desktop 
shortcut option. After this, click on [Next] button to continue. 
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▪ The Ready to Install panel will be shown. Click on [Install] button to continue. 

 

▪ The Installing panel informs about the installation process. 

 

▪ During this process the software is installed in a new folder called 
[Panlab\Record-it! Media v1.0], created under the “C:\Programs Files” folder. 
The location of the software is independent of the data folder, which is 
defined by the user using the corresponding options of the program. 
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▪ Another repository folder named Record-it! Video Recording is created in the 
Public Documents folder. 

 

▪ Once the installation is finished, the following panel is displayed. 

 

▪ A new shortcut will appear on your desktop. Use it for executing the 
program later. 

A PDF reader must be installed on your computer in order to view the User’s 
Manual. Adobe Acrobat Reader is provided in the installation key. If needed, click 
on Install Acrobat Reader button, and follow the steps to install it.  

Use the Contact us option to email our team directly with questions. 
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2.3. The USB protection key 

A software protection key is a device used to prevent software from unlawful use. 
The license key is connected to the computer via a free USB 2.0 port. Only one key 
is provided per purchased license, this is a single-seat license for recording video. 
If you are interested in recording from multiple computers, purchase of additional 
license keys is required. 

The license key is needed for video recording only, not for using the RECORD-IT! 
MEDIA player. 

To make use of the protection key, make sure it is plugged into the USB 2.0 port 
before RECORD-IT! MEDIA has started. 

Please DO NOT rename the USB unit (its name should always be 
PBLICENSE). 

Please DO NOT remove or modify any file stored within the USB flash key, 
especially the regkey.dat file which stores the information regarding your license 
of use. 

The License Status will then be shown as Valid in the status bar. 

 

If the license key is not detected by the computer, the status bar will show License-
Key not found as License Status. 

 

And the following message will appear when clicking on one of the START 
recording buttons: 
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2.4. Testing Record-IT! Media: the Trial Period 

This section only applies if you have acquired a trial version of Record-IT! Media 
available for download at http://www.panlab.com/. 

The trial period is 15 days counted from the first time Record-IT! Media is executed 
and is intended for testing purposes. During this period, Record-IT! Media is 
limited to 4 cameras and 4 min recording time per video. In case the user doesn’t 
currently have a camera compatible with the application, Record-it! Media 
provides simulated image sources (see 2.5.6) 

 

The trial period information can be accessed throughout the Help About menu 
option: 

 

The “Trial Version” field shows the status of the trial period. Once the trial period 
expired, a warning message is shown, and Record-IT! Media will no longer execute. 

If required, in special cases, the trial period can be extended upon special request. 
Please contact your dealer for further details. 
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2.5. Supported cameras for video recording 

RECORD-IT! MEDIA processes the images (frames) coming from the connected 
image sources (cameras). 

The cameras supported by RECORD-IT! MEDIA are: 

▪ Digital USB cameras, Webcams, WIA cameras. 

▪ Analogic cameras (requires an analog-digital converter). Multi-

camera mode is not possible with analogic cameras. In other terms, 

only 1 image source/camera can be detected. 

▪ IP Network cameras. 

RECORD-IT! MEDIA also provides simulated live image video sources for demo 
purposes. 
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2.5.1. Webcam 

Standard USB webcams are one of the commonly used live image sources. They 
offer a reasonable trade-off between image quality and cost. However, due to 
technical limitations of the USB communication protocol, webcams cannot be 
used with long distances between the computer and the arenas. RECORD-IT! 
MEDIA can record from up to 4 webcams simultaneously at 16 fps as maximum 
frame rate. If more than one webcam is to be connected, we recommend use of a 
specific 4-port USB Hub (Renkforce; 4 Port USB 3.0 HUB). 

From Panlab-Harvard Apparatus, we recommend the use of the Logitech HD C9xx 
series of webcams. 

Please refer to the manufacturer instructions to install the drivers of the webcam 
and avoid installing the generic drivers that Windows may try to install by default. 

 

 

Other standard USB webcams may be installed following a similar procedure which 
is described in detail in the Manual. 

If the recordings are to be processed through an external video-tracking 
system, please note that USB Webcams may include auto-adjustment 
tools for focus, brightness, contrast, and face tracking. Make sure that 
these options are disabled before using your webcam for video 

recording. 
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2.5.2. Digital USB 3.0 cameras and USB cables 

Even through RECORD-IT! MEDIA can work with several models of digital USB 3.0 
cameras (provided that the correct driver is correctly installed), we only ensure 
total compatibility with the digital USB 3.0 cameras manufactured by Basler. 

Connecting a USB 2.0 camera to a USB 3.0 port will not increase the 
performance of the camera. Similarly, connecting a USB 3.0 camera to 
a USB 2.0 port will make the camera work as a 2.0 camera. 

 

Using a USB Hub to expand a USB port to 4 ports, it will be possible to connect up 
to 4 Digital USB 3.0 cameras simultaneously using RECORD-IT! MEDIA. On the 
other hand, in order to connect more than 4 cameras, an expansion card (PCIe) 
will be necessary. For example, one PCIe connected to 4 USB Hub will allow to 
connect up to 16 Digital USB 3.0 cameras simultaneously using RECORD-IT! MEDIA. 
In this case, please follow the manufacturer instructions to install it. Please be 
aware that you will need to power the PCIe connecting it to a cable from the power 
unit within the PC, so it would be better to use a slot near the power unit. Ask your 
IT Department if you need further assistance. 

Depending on the configuration purchased we provide 3 USB cable length options 
with our cameras: 3 m, 5 m or 8 m (5 m cable with a 3 m extension cable). 

Table 2 reports the maximum frame rate allowed for each camera model, 
depending on the number of cameras simultaneously connected: 

Table 1: USB 3.0 cameras 

REFERENCE SENSOR RESOLUTION 

FPS per number of cameras 

1 2-4† 5-8*† 9-16*† 

CAMDC3COLOR Color 

1280X960 25 20 - - 

640X480 25 20 16 16 

CAMDC3BW Monochrome 

1280X960 25 20 - - 

640X480 25 20 16 16 

†Need 1 to 4 USB 3.0 Hub 

*Need PCIe USB 3.0 
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2.5.2.1. Installing the drivers of the Basler USB digital cameras 

1. Unpack the Device 

2. IMPORTANT: Do not plug the camera into any USB port before step 

7 of this installation guide. 

3. Please make sure to have administrative privileges for the computer 

where the device will be installed. Contact your IT staff to ensure you 

have administrative rights before continuing with this procedure. 

4. Plug the installation key of Record-It! Media into a USB 2.0 port and 

launch the installation tool (PANLAB.EXE). 

5. Select the Hardware Drivers option. 

 

6. Enter the Basler Digital 3.0 – Basler GigE Vision folder and execute 

the file. 

7. Read and accept the Terms & Conditions. Then click on Next. 
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8. Select the Camera User profile 

 

 
 

9. In the Interfaces window, select only USB and GigE. To avoid lagging 

problems during the use of the device in SMARTIO, do not select CXP 

or Camera Link. Click on Next. 

 

 
 

10. Specify the destination folder and click on Next 
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11. Click on Install to proceed with the installation. 

 

 

 

12. Click on the Close button to finish the installation. Restarting the 

computer is advised. 

 

 

 

13. Plug the device to a free USB port. 

 

14. Windows 11 will automatically install the cameras. If working with 

Windows 10, wait for the Windows Device installation assistant to 

launch and follow the default steps until finishing. 
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15. In Device Manager, check that the cameras are detected.  

 

 

 

2.5.2.2. Configuring Basler USB digital cameras with Pylon Viewer 

Configuring a new camera model 

1. Select Tools > Pylon USB Configurator 

 

2. Identify the cameras connected: the path may change whether the 

camera is connected directly to the motherboard, through a USB Hub 

or an additional PCIe card. 
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3. Click on the camera and go to the Details table. 

4. Check that the Serial Number of the camera is correct, that the Is 

operative at: field shows USB 3.n device and that Supported bus 

speeds: indicates High-Speed, Super-Speed. 

 

 

If the Is operative at: field shows USB 2.n device, the speed of 
the bus would not be enough to support the performance of the 
camera(s). Remove the USB cable from the USB 2 port and 
connect it to a USB 3 and restart from step 12 of chapter 2.5.2.1. 

5. Click on  File > Exit to close the USB configurator  

6. Under the Devices section, select the camera and identify the 

camera by its serial number; 

 

7. Select Camera > Open Device 

 

8. Select Category > Image Format Control 
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9. Insert the value 2 in Binning Horizontal and Binning Vertical 

 

 

10. Click on  on the top main menu to open the preview of the 

camera 

 

11. Click on the Features – Basic tab shown at the bottom left of the 

Pylon application main window.  

 
 

12. Set Exposure Auto, Gain Auto and Balance Whites on OFF 

 
 

13. Set the optimal Exposure Time and  Gain [dB] to have a clear and 

definde image. 

14. Click on  on the top menu to stop the preview. 

15. Come back to the Features – all tab and select Category > User Set 

Control 

 
 

Different settings may be saved in different User Sets if the same 

camera is intended to be used with different light conditions. In 
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SMARTIO it will be possible to select the correct setting when 

defining the image settings 

16. Select User Set Selector > User Set 1 and User Set Default > User Set 

1 

 
 

17. Select User Set Save > Execute to save the configuration 

 

 

18. Select Camera > Save Features and indicate name and path of the 

configuration file 

 
 

 
 

19. Select Camera > Close Device to exit 
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2.5.2.3. Configuring a camera of an existing model 

If using multiple cameras of the same model, follow the next steps to apply the 
same configuration to all the cameras 

 

1. Follow the Steps 1-5 of the previous section 

 

2. Select Camera > Load Features …  to load a pre-exisiting configuration 

file 

 
 

 
 

3. Select User Set Selector > User Set 1 
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4. Select User Set Save > Execute to save the configuration 

 
 

5. Select User Set Default > User Set 1 to define this configuration as default 

 
 

 
 

6. Select the tab Features – Basic to visualize a summary of the selected 

configuration 

 
 

7. Select Camera > Close Device to exit 
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2.5.2.4. Configuring the correct bandwidth/frame rate for each camera 

The factory configuration of the cameras are set by default to high resolutions. This 
seetings need to be lowered for an optimal use with our video solutions. The 
following step is very important so to ensure the performance of the video 
recording process (frame rate/resolution). 

1. Once configured all the cameras connected to the PC, open Tools > 

Bandwidth Manager 

 
 

2. Select all the cameras 

 
 

3. The bandwidth of the USB Controller (or the Hub) and the bandwidth per 

each camera are shown in the column Bandwidth (MB/s). The sum of all 

the bandwidths of the cameras must be lower of the total bandwidth of 

the USB Controller. In this case, 163 MB/s per two cameras is 326 MB/s 

total, which is lower than 450 MB/s. 

 
 

If the sum of the bandwidth of all the cameras exceeds the bandiwdth of 

the USB controller, divide this last value for the total number of cameras 

+ 1. 

In this example, the four cameras use a total bandwidth of 

 

163/s * 4 = 652 MB/s 

which is higher than 450 MB/s managed by the USB controller. 

 
 

Divide 450 MB/s by (4+1) = 5 cameras (total 90 MB/s) and modify the 

bandwidth per each camera. 
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4. Click on Start Analysis 

 

5. Check the value under the column fps Sent is higher than the values 

reported in Table 1 (for the number of cameras connected). Check that 

no errors are shown under the column Errors. 

 

 

6. Click on Stop Analysis and then on Close to exit the Bandwidth Manager. 

 

  

http://www.panlab.com/


 

 

 

Page 25 

Record-IT! Media Manual • Publication MAN-SOFT RECORD-IT MEDIA REV 08 • www.panlab.com ©2024 Panlab 

2.5.3. Digital USB 2.0 cameras and USB cables 

RECORD-IT! MEDIA works with a wide variety of digital cameras (provided that the 
relevant driver is correctly installed), but we only ensure total compatibility with 
the digital USB 2.0 cameras manufactured by IDS and The Imaging Source (TIS). 
Panlab-Harvard Apparatus can only provide after-sales support on the RECORD-IT! 
MEDIA camera management if used with the models recommended in this User 
Manual. 

Depending on the configuration purchased we provide 3 USB cable length options 
with our cameras: 3, 5 or 8 m. 

The digital cameras provide high-resolution images at frame rate of up to 40 fps. 
The quality of the images and the minimal installation requirements make the 
digital cameras ideal for video tracking. 

 

2.5.3.1. Installing TIS Digital USB 2.0 Cameras 

RECORD-IT! MEDIA can manage one TIS Digital USB 2.0 camera at a time. Once 
plugged in, the camera is recognized by Windows, but it will be necessary to install 
the drivers in order to manage it. To install a TIS digital camera in Windows® 
systems, please follow the next steps:  

 

1. Unpack the camera and remove the CS/C lens adapter ring supplied with 

the camera before mounting the lens. 

 

 
 

2. Plug the device to a free USB 2.0 or USB 3.0 port. Once plugged in, 

Windows recognized that there is a connected device, but it will be 

necessary to install the drivers in order to manage the camera.  

3. Please make sure to have administrative privileges in the computer in 

which the device will be installed. Contact your IT staff to confirm this 

issue before continuing with this procedure. 

4. Plug the installation key of RECORD-IT! MEDIA into a USB 2.0 port and 

launch the installation tool (PANLAB.EXE). 
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5. Select the “Hardware Drivers” option. 

 

6. Enter the “Digital Camera Drivers -> TIS USB 2.0 Digital Camera” folder 

and execute the .exe file. Then follow all the steps with the default 

options. 

7. Click the ‘Finish’ button to finish the installation. 

8. Wait for the Windows Device installation assistant to launch and follow 

the default steps until finishing. 

 

2.5.3.2. Installing IDS Digital USB 2.0 Cameras (Legacy mode) 

Using a USB Hub to expand a USB port to 4 ports, it will be possible to connect up 
to 4 Digital USB 2.0 cameras simultaneously using RECORD-IT! MEDIA. On the 
other hand, in order to connect more than 4 cameras, an expansion card (PCIe) 
will be necessary. For example, one PCIe connected to 4 USB Hub will allow to 
connect up to 16 Digital USB 2.0 cameras simultaneously using RECORD!-IT MEDIA. 
In this case, please follow the manufacturer instructions to install it. Please be 
aware that you will need to power the PCIe connecting it to a cable from the power 
unit within the PC, so it would be better to use a slot near the power unit. Ask your 
IT Department if you need further assistance. 

Table 1, reports the maximum frame rate allowed for each camera model 
depending on the number of cameras: 
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Table 2: USB 2.0 (IDS) cameras 

REFERENCE SENSOR RESOLUTION 

FPS per number of cameras 

1 2-4† 5-8*† 9-16*† 

CAMDCCOLOR$ Color 640X480 25 25 25 15 

CAMDCBW$ Monochrome 640X480 25 25 25 15 

CAMDCNIR NIR 640X480 25 16 10 - 

†Need 1 to 4 USB 3.0 Hub 

*Need PCIe USB 3.0 

$Legacy Model 
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To install an IDS digital camera in Windows® systems, please follow the next steps: 

1. Unpack the camera, remove the O-ring from the objective and mount the 

lens. If the O-ring is not removed, the image received from the camera may 

be blurry. This ring may be black or silver in color. 

 

2. IMPORTANT: Do not plug the camera into any USB port before step 7 of this 

installation guide. 

3. Please make sure to have administrative privileges for the computer where 

the device will be installed. Contact your IT staff to ensure you have 

administrative rights before continuing with this procedure. 

4. Plug the installation key of RECORD-IT! MEDIA into a USB 2.0 port and launch 

the installation tool (PANLAB.EXE). 

5. Select the Hardware Drivers option. 

 

6. Enter the “Digital Camera Drivers -> IDS Digital Camera” folder and execute 

the correct .exe file (32 or 64 bit depending on the version of Windows). Then 

follow all the steps with the default options. 

7. Click the Finish button to finish the installation. Restarting your computer is 

advised. 

8. Plug the device to a free USB port. 

9. Wait for the Windows Device installation assistant to launch and follow the 

default steps until finishing. 

10. To use the device, go to the RECORD-IT! MEDIA Image Source manager (refer 

to chapter 4.2) and select the USB Digital camera image source (refer to 

chapter 4.2.2). 

 

Digital USB 2.0 cameras settings (ID, frame rate) 

▪ When working with the IDS digital USB cameras, several parameters need to 
be set for optimal video recording process: 
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• Internal camera ID (especially if working with a multiple camera setup)  

• Frame rate and frame size, this will depend on the available USB 
communication bandwidth. 

 

Set the internal ID of the IDS camera 

Follow the next steps: 

1. Open the “IDS Camera Manager” (the shortcut should be available from 

the desktop). 

 

 
 

2. Connect the first camera. If a USB HUB is needed to connect multiple 

cameras to the computer, make sure that you connect the camera first 

to the USB Hub and then USB HUB to the computer. The camera will be 

automatically detected by the IDS Camera Manager and displayed in the 

Camera list. 
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The IDS Camera Manager displays the camera Serial Number (SerNo.) as 

well as the Camera ID (Cam.ID) and Device ID (Dev.ID). The camera will 

be automatically assigned as ID 1. 

We recommend the user place an identification label on the camera to 

prevent confusion between the individual cameras used in the same 

setup. 

 

3. Connect the second camera. The camera will be automatically detected 

by the IDS Camera Manager and displayed in the Camera list. 

 
The IDS Camera Manager displays the camera Serial Number (SerNo.) as 

well as the Camera ID (Cam.ID) and Device ID (Dev.ID). The IDS Camera 

Manager always sets the Camera ID (Cam.ID) to 1. The Cam.ID should be 

changed to 2. 

 

4. Click on the Camera Information button in the Control center section and 

change the Camera ID to 2, then click on the OK button. 
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5. Connect the third camera. 

The camera will be automatically detected by the IDS Camera Manager 

and displayed in the Camera list. 

 
 

▪ The IDS Camera Manager displays the camera Serial Number (SerNo.) as 

well as the Camera ID (Cam.ID) and Device ID (Dev.ID). 

 

▪ The IDS Camera Manager always sets the Camera ID (Cam.ID) to 1. The 

Cam.ID should be changed to 3. 

 

6. Click on the Camera Information button in the Control center section and 

change the Camera ID to 3, then click on the OK button. 

 

 

 

7. Connect the next camera and repeat the step until all the cameras have 

been connected and set with an appropriate ID. 

8. Make sure that all the cameras have a different ID number. 
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2.5.3.3. Setting the optimal frame rate that will be used for the video recording 

1. Click on the Additional functions button in the Control center section, 

choose the Parameter Set option and click on the Close button to Exit. 

 

 

 
 

2. Select Camera 1 in the table, right-click and then choose the “Open 

viewer...” option in the list. 
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The IDS Camera Manager will provide the view of the images coming 

from the camera. 

 

 

3. Click on the View main menu and select the Performance overview 

option and note the value of the Max Interface bandwith. 
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In this example the Max interface bandwidth value is 38.0 MB/s. This is 

the shared USB communication bandwidth available to all cameras 

connected to the same USB HUB or computer USB port. 

 

If 4 cameras are connected to this USB HUB/computer USB port, then the 

available bandwidth available for each camera would be 38.0/4 = 9.5. 

Round this value to the lower value: 9 MB/s. 

4. Click on the Camera properties button and display the Camera Tab. 

 

 

5. Set the Pixel Clock to the calculated value (9 in this example): 
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6. The values shown in the Frame rate section of the screen will update. 

Check the Max option to display the maximum frame rate that can be 

used for each cameras: here 19 fps. 

 

7. Save the Parameter set by selecting the Save Parameters/Parameter set 

option of the File main menu. 
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8. Close the uEye Cockpit panel of the Camera 1. 

 

 

9. Close the Camera 1 Viewer 

 

 

10. Repeat the same operation with all cameras: 

 

 

• Select Camera 2 in the table, right-click and then choose the Open 

viewer... option in the list. 

• Click on the Camera properties button and display the Camera Tab. 

• Set the Pixel Clock to the calculated value (9 in this example). 

• The values shown in the Frame rate section of the screen will update. 

Check the Max option to display the maximum frame rate that can be 

used for each cameras: here 19 fps. 

• Save the Parameter set by selecting the Save Parameters/Parameter set 

option of the File main menu. 

• Close the uEye Cockpit panel of the Camera 2. 

• Close the Camera2 Viewer. 

• Select Camera 3 in the table, click right and then choose the Open 

viewer... option in the list. 

• Etc. 
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11. Close the IDS Camera Manager when all cameras are set 

 

 

2.5.3.4. Set the optimal frame rate in RECORD-IT! MEDIA when defining the 

cameras (see chapter 4.2.2) 

Select a frame rate value equal to or lower than the calculated MAX Frame Rate 
(from Step 6 above). The max frame rate calculated was 19 fps in our example, so 
16 fps is the closest available that is equal or LOWER. 

 
 

The selected frame value should always be lower or equal to the 

calculated optimal value. 

If the selected frame rate is greater than the calculated optimal value, 
some problems may occur with the recorded video (performance issues, 
incoherent video file duration, … ). 
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2.5.4. Network cameras 

RECORD-IT! MEDIA is compatible with ONVIF and non-ONVIF Network cameras. 

• For ONVIF cameras, RECORD-IT! MEDIA provides direct access to the 

camera settings. 

• For non-ONVIF cameras, please follow the manufacturer’s set-up 

instructions prior to using RECORD-IT! MEDIA. RECORD-IT! MEDIA will 

only provide access to the camera images (RTSP Streaming), but not to 

its settings. 

Most IP cameras can stream video using a RTSP URL request. Contact the camera 
supplier/manufacturer to get the correct RTSP URL address for your camera 
model. 

IP cameras are designed to be used on Ethernet networks. An IP address is needed 
to access the camera. Please, contact your IT to connect your IP camera(s) to your 
Ethernet network. 

 

It is possible to connect up to 16 cameras simultaneously. However, be aware that 
you will need an Ethernet Switch POE to connect more than one camera at the 
same time. The main requirement for ONVIF cameras is to have Profile S protocol. 

The main requirement for non-ONVIF cameras is to fulfill the RTSP protocol. 
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Table 3 reports the maximum frame rate allowed for each camera model, 
depending on the number of cameras simultaneously connected: 

 

Table 3: Network ONVIF Profile S cameras 

MODEL SENSOR PROTOCOL RESOLUTION 

FPS per number of cameras 

1 2-4◊ 5-8◊ 9-16◊ 

Tested 
with Axis 

M1134 
Network 
Camera 

Color 
ONVIF 

Profile S 
1280X960 25 20 16 16 

◊ Need 1 to 2 Ethernet Switch   
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Network considerations: 

When working with IP Network cameras, the network infrastructure 
(LAN/WAN) and performance of your experimental facilities is an 
important point to be considered. If bandwidth bottlenecks occur, 
streaming video can show jitter, delay, or corruption. This could result 
in the video not getting recorded or showing aberrant duration.  

 

2.5.5. Installing an analog-digital converter for analogic cameras 

Our analog-digital video converter (CONVANAUSB) enables the use of analogic 
image technology by digitizing the incoming images of analogic sources. 

The analog-digital video converter (CONVANAUSB) is an optional accessory that 
can be purchased with your RECORD-IT! MEDIA system. Please contact your dealer 
to find out the advantages of this accessory and how to acquire it. 

Only one analog-digital video converter (CONVANAUSB) can be plugged 
into the computer. This option cannot be used for multiple camera 
needs. 

Before using the device, the corresponding drivers must be installed. 

Three different versions of the analog-digital video converter have been released, 
each one of them requiring different drivers. 

 

Before continuing, please check which version you have in your system: 

Version 1 Version 2 Version 3 

  

 

 

2.5.5.1. Installing Version 1 of the Analog-Digital Converter 

To install the device in Windows® systems, please follow the next steps:  

1. IMPORTANT: Do not plug the device into any USB port before step no. 7 of 

this installation guide. 

2. Please make sure to have administrative privileges for the computer where 

the device will be installed. Contact your IT staff to ensure you have 

administrative rights before continuing with this procedure. 
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3. Plug the installation key of RECORD-IT! MEDIA into a USB 2.0 port and launch 

the installation tool (PANLAB.EXE). 

4. Select the Hardware Drivers option. 

 

5. Enter the “Analog Camera -> CONVANAUSB Drivers ->Version 1” folder and 

execute the correct .exe file (32 or 64 bit depending on the version of 

Windows). Then follow all the steps with the default options. 

6. Click the Finish button to finish the installation. Restarting your computer is 

advised.  

7. Plug the device into a free USB 2.0 port. Make sure to remove the yellow label 

from the USB end of the cable first. 

8. Wait for the Windows Device installation assistant to launch and follow the 

default steps until finishing. 

9. To use the device, go to the RECORD-IT! MEDIA Image Source manager (refer 

to chapter 4.2) and select the Analog-Digital Converter image source (refer to 

chapter 4.2.5). 

2.5.5.2. Installing Version 2 or Version 3 of the Analog-Digital Converter 

To install the device in Windows® systems, please follow the next steps:  

1. IMPORTANT: Do not plug the device into any USB port before step no. 7 of 

this installation guide. 

2. Please make sure to have administrative privileges for the computer where 

the device will be installed. Contact your IT staff to ensure you have 

administrative rights before continuing with this procedure. 

3. Plug the installation key of RECORD-IT! MEDIA into a USB 2.0 port and launch 

the installation tool (PANLAB.EXE). 

4. Select the Hardware Drivers option. 
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5. Enter the “Analog Camera -> CONVANAUSB Drivers ->Version 2 to 4” folder 

and execute the .exe file. Then follow all the steps with the default options. 

6. Click the Finish button to finish the installation. Restarting your computer is 

advised. 

7. Plug the device into a free USB 2.0 port. Make sure to remove the yellow label 

from the USB end of the cable first. 

8. Wait for the Windows Device installation assistant to launch and follow the 

default steps until finishing. 

9. To use the device, go to the RECORD-IT! MEDIA Image Source manager (refer 

to chapter 4.2) and select the Analog-Digital Converter image source (refer 

to chapter 4.2.5). 

2.5.6. Simulated live image source 

Three additional simulated live image sources can be used in RECORD-IT! MEDIA 
for demo purposes. A simulated live image is a “live image” that is not fed by an 
on-line camera but is digitally built on an already recorded video file played in a 
closed loop. 

• Camera Simulator - Computer generated: RECORD-IT! MEDIA provides the 

live image of a moving red dot on a grey background. 

 

• Camera Simulator - Recorded Subject: RECORD-IT! MEDIA provides the live 

image of a moving white mouse on a black background. 

 

• Camera Simulator - Custom Recorded video: RECORD-IT! MEDIA provides a 

tool for selecting a user video file. 

Recommended frame rate for maximum performance on 8 simulated cameras: 5 
fps.  
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2.6. Codecs and supported video files 

Digital video files can store large image sequences into relatively small files. To do 
that, digital recorders use the compression and codification methods that reduce 
the final size of the file. 

Compression and codification processes are carried out by a special software 
component called CODEC (CO-mpressor/DEC-ompressor) that should be installed 
both on the recorder and in the reader devices. 

Each CODEC can deal with a variety of digital video formats, according to vendor 
specifications. For this reason, RECORD-IT! MEDIA can manage digital video files in 
a variety of formats, provided the corresponding CODEC is already installed. 

The CODECS used by RECORD-IT! MEDIA are the H.264/MPEG-4 AVC codec (Xvid 
equivalent), providing file with the *.mkv extension. 

When installing the RECORD-IT! MEDIA software, the H.264/MPEG-4 AVC (Xvid) 
will be automatically installed.  

Please note that Microsoft Windows® operating system includes CODECs for 
several standard video formats such as MPEG-4 or Indeo®. RECORD-IT! MEDIA 
installation software also includes additional CODECs to process the video 
recorded using the H.264/MP4AVC codec and other formats such as VOB files. 

Installing additional CODECs will allow RECORD-IT! MEDIA to open any digital video 
format, for example DIVX or SVCD. 

 

Most CODECs discard some of the original data to reduce the file size. 
Although a CODEC tries to remove only portions of the data that 
humans are not likely to note, if the compression level of a video file is 

too high, portions of the removed data will be easily notable, and accuracy will be 
lost. Therefore, when using CODECs to compress your video, there is a trade-off 
between quality and file size. 

 

PANLAB suggests the H.264/MPEG-4 AVC (Xvid) implementation provided within 
the software or, if possible, acquiring the commercial edition of the CODEC used.  
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2.6.1. Installing the H.264/MPEG-4 AVC codec manually 

This CODEC is installed automatically on the computer when the RECORD-IT! 
MEDIA software is installed. 

In case a manual installation should be required, please follow these steps: 

1. Plug the installation key of Record-It! Media into a USB 2.0 port and launch 

the installation tool (PANLAB.EXE). 

2. Select the Video Codecs option. 

 

3. Execute the Xvid Codec.exe file. Then follow all the steps with the default 

options. 

4. Click the Finish button to finish the installation. 

5. Execute the Configure Encoder tool located at the Start > All programs > Xvid 

folder. 

6. Click on the Other options… button located at the bottom of the Xvid 

Configuration window. 

7. Uncheck the option Display encoding status and click on the OK button. 

 

8. Then click on the OK button in the Xvid Configuration window.  
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2.6.2. Installing codecs to process external MPEG-4 videos 

To open the MPEG-4 video files, an MPEG-4 video decoder must be installed on 
the computer where Record-It Media! is being utilized. 

1. Plug the installation key of RECORD-IT! MEDIA into a USB 2.0 port and launch 

the installation tool (PANLAB.EXE). 

2. Select the Digital Video Codecs option. 

 

3. Execute the Ffdshow Codec.exe file. Then follow all steps by selecting the 

default options until the installation is finished. 
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2.7. Supported and unsupported video file formats 

RECORD-IT! MEDIA supports all common digital video formats. It contains 
proprietary decoding systems that can decode most of the existing video formats. 

However, in some special cases, it is possible that the digital video file cannot be 
opened by RECORD-IT! MEDIA. Also, it is possible that it does not playback 
correctly or that it requires a special codec to be installed on the system. 

Table 4 shows a subset of the most common formats supported by RECORD-IT! 
MEDIA: 

Table 4: File extensions supported by RECORD-IT! MEDIA 

 

 

The above-mentioned formats contain video streams that may be compressed 
with different codecs. RECORD-IT! MEDIA supports the codecs specified in the 
following list. Additional codecs are supported if the corresponding codec is 
installed in the system. 

8088flex TMV LCL (LossLess Codec Library) MSZH 

Amazing Studio PAF Video LOCO 

AMV Video LucasArts SANM/Smush 

ANSI/ASCII art lossless MJPEG 

Apple Intermediate Codec Microsoft ATC Screen 

Apple MJPEG-B Microsoft Expression Encoder Screen 

Apple ProRes Microsoft RLE 

QuickTime *.mov, *.qt

Moving Picture Experts 

Group  

*.mpg, *.mpeg, 

*.mp4, *.m4v, 

Matroska Multimedia 

Container
*.mkv 

Video format
Usual file 

extension

Audio Video Interleave *.avi

Windows Media Video *.wmv, *.asf
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Apple QuickDraw Microsoft Screen 1 

Asus v1 Microsoft Screen 2 

Asus v2 Microsoft Video 1 

ATI VCR1 Mimic 

ATI VCR2 Miro VideoXL 

Auravision Aura MJPEG (Motion JPEG) 

Auravision Aura 2 Mobotix MxPEG video 

Autodesk Animator Flic video Motion Pixels video 

Autodesk RLE MPEG-1 video 

Avid 1:1 10-bit RGB Packer MPEG-2 video 

AVS (Audio Video Standard) video MPEG-4 part 2 

AYUV MPEG-4 part 2 Microsoft variant version 1 

Beam Software VB MPEG-4 part 2 Microsoft variant version 2 

Bink Video MPEG-4 part 2 Microsoft variant version 3 

Bitmap Brothers JV video Nintendo Gamecube THP video 

y41p Brooktree uncompressed 
4:1:1 12-bit 

NuppelVideo/RTjpeg 

CamStudio On2 VP3 

CD+G On2 VP5 

CDXL On2 VP6 

Chinese AVS video On2 VP7 

Discworld II BMV Video VP8 
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Canopus Lossless Codec VP9 

Cinepak Pinnacle TARGA CineWave YUV16 

Cirrus Logic AccuPak Prores 

CPiA Video Format Q-team QPEG 

Creative YUV (CYUV) QuickTime 8BPS video 

Deluxe Paint Animation QuickTime Animation (RLE) video 

DNxHD QuickTime Graphics (SMC) 

Duck TrueMotion 1.0 QuickTime video (RPZA) 

Duck TrueMotion 2.0 R10K AJA Kona 10-bit RGB Codec 

DV (Digital Video) R210 Quicktime Uncompressed RGB 10-bit 

Dxtory capture format Raw Video 

Electronic Arts CMV video RealVideo 1.0 

Electronic Arts Madcow video RealVideo 2.0 

Electronic Arts TGV video RealVideo 4.0 

Electronic Arts TGQ video Renderware TXD (TeXture Dictionary) 

Electronic Arts TQI video SGI RLE 8-bit 

Escape 124 Sierra VMD video 

Escape 130 Silicon Graphics Motion Video Compressor 
1 (MVC1) 

FFmpeg video codec #1 Silicon Graphics Motion Video Compressor 
2 (MVC2) 

Flash Screen Video v1 Smacker video 

Flash Screen Video v2 SMPTE VC-1 
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Flash Video (FLV) Sony PlayStation MDEC (Motion DECoder) 

Forward Uncompressed Sorenson Vector Quantizer 1 

Fraps Sorenson Vector Quantizer 3 

Go2Webinar Sunplus JPEG (SP5X) 

H.261 TechSmith Screen Capture Codec 

H.263 / H.263-1996 TechSmith Screen Capture Codec 2 

H.263+ / H.263-1998 / H.263 
version 2 

Theora 

H.264 / AVC / MPEG-4 AVC / 
MPEG-4 part 10 

Ut Video 

HEVC v210 QuickTime uncompressed 4:2:2 10-
bit 

HNM version 4 v308 QuickTime uncompressed 4:4:4 

HuffYUV v408 QuickTime uncompressed 4:4:4:4 

HuffYUV FFmpeg variant v410 QuickTime uncompressed 4:4:4 10-
bit 

IBM Ultimotion VBLE Lossless Codec 

id Cinematic video VMware Screen Codec / VMware Video 

id RoQ video Westwood Studios VQA (Vector Quantized 
Animation) 

IFF ILBM Windows Media Image 

IFF ByteRun1 Windows Media Video 7 

Intel H.263 Windows Media Video 8 

Intel Indeo 2 Wing Commander III / Xan 

Intel Indeo 3 Wing Commander IV / Xan 
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Intel Indeo 4 Winnov WNV1 

Intel Indeo 5 WMV7 

Interplay MVE video YAMAHA SMAF 

J2K Psygnosis YOP Video 

Karl Morton’s video codec YUV4 

Lagarith ZeroCodec Lossless Video 

 

RECORD-IT! MEDIA does not support videos with DRM (Digital Rights 
Management) protection. 

Incompatibilities with K-Lite Codec Pack has also been detected and they may 
affect the acquisition process in “.avi” digital video files. It is strongly 
recommended to avoid installing this codec pack. 

2.8. Video-tracking considerations 

Files recorded through the RECORD-IT! MEDIA software may be uploaded to an 
external video-tracking system, such as SMART, for collection of various behavioral 
data. Video-tracking requires specific environmental conditions and video settings, 
dependent on the application. These factors should be considered prior to use of 
the RECORD-IT! MEDIA software to ensure that parameters are appropriate for the 
experimental goals and per the recommendations of the video-tracking 
manufacturer.    

Please consult the user’s manual of the video-tracking system for specific 
recommendations for the following points: 

• Camera frame rate settings (no more than 16 fps) 

• Camera/lens resolution, angle of vision, and manual/automated 
adjustments 

• Camera model: color / B&W / Infra-red 

• Camera positioning /support 

• Lighting conditions 

• Video Duration 

• Maze & enclosure size, material, and color 

• Etc. 
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3. STARTING WITH RECORD-IT! MEDIA 

The RECORD-IT! MEDIA Software can be launched manually through the desktop 
icon. 

 

 

3.1. Main Menu 

The main screen of RECORD-IT! MEDIA offers 3 tabs: 

• Recording: section of the software used for video recording and saving. 

• Player: section of the software used for visualizing video files. 

• Help: section providing information about the application version, serial 
number, and contact data. 
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4. RECORDING 

The Recording section of RECORD-IT! MEDIA provides 5 sub-sections: 

• Project 

• Image Sources 

• Storage 

• Settings 

• Recording 

 

4.1. Project management 

All the settings used for recording from one or more cameras are saved in a Record-
it! Media project file. 

The Record-it! Media project files are managed through the File Menu. 
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Back to the recording main panel 

  

Create a new recording project file 

 

Open a recording project file 

 

Save the current recording project file 

 

Save the current recording project file with 
another name 

 

Add project file info 

 

Close the project file 

  

Show the list of the recently used recording 
projects 

 

Define the path to save the recording 
project files and the recorded videos 

 

4.1.1. Create a new Record-it Project File 

Click on the New button in the menu and then select the New Record-it Project 
file option. 
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Fill the Project File Info with the information of your preference. 

 

The Project File Info panel provides 2 freely editable sections: Title and 
Comments. 

 

In this panel, RECORD-IT! MEDIA also shows the date/time of the Last 
Modification saved in the project file. 

Click on the Accept button when done, then indicate the name and location where 
the file would be saved. By default, the path setting proposed is 
C:\Users\Public\Documents\Record-it! Video Recording\Projects\. 
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Then click on the Save button to save the project file. The name of the file will then 
be displayed on the top bar of the application. 

 

The project info can be changed and saved at any time through the Info – Project 
Info menu of the Main File Menu. 

 

 

4.1.2. Open a RECORD-IT! MEDIA Project File 

To open an already existing Record-IT! Project file, click on the Open button, select 
the file of interest from the Open File window and then click on the Open button. 

 

 

RECORD-IT! MEDIA will then load the camera and recording settings into the main 
panel. 

The user can also open a RECORD-IT! MEDIA Project file from the list of recent files 
displayed when selecting the Recent – Recently used project menu. 
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4.1.3. Change the project and video files path settings 

To change the path settings for the RECORD-IT! MEDIA Project files and recorded 
videos, select the Settings – System Settings menu and choose another location 
for saving these files. 
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4.2. Image Sources 

Click on the Image Sources main button to access the image source configuration 
table. 

 

From the Image Source - Setting table, up to 16 cameras can be added. After 
adding one or several image sources, the following panel will resume the 
information about each of them: 

 

The Data Rate column indicates the amount of data required by each camera. In 
the bottom right angle, the line Total Data Rate reports the sum of the data rates 
of all the image sources. It has been validated a correct functioning of the system 
when the Total Data Rate is below 120 MB/s. In case its value is higher, a warning 
sign is shown: 

1. Click on Accept to open simultaneously all the image sources. 

2. Start a recording (see chapter 4.6). 

3. Open the Task Manager and check that the CPU usage is below 50%. If it 

is higher, consider reducing the number of FPS, the frame size or the 

number of image sources simultaneously working.  
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The following action buttons are available from the menu. 

 

Add a camera to the image source table 

 

Remove a camera from the image source table 

(an image source must be selected in the table before clicking on 
this button). 

 

Edit configuration of the selected image source 

(an image source must be selected in the table before clicking on 
this button). 

 

Move the selected camera to the top position (first position in the 
list) 

 

Move the selected camera to the last position in the list 

 

Move the selected camera one position up 

 

Move the selected camera one position down 

 

4.2.1. Add a webcam image source 

▪ Click on the  button to open the Image Source Setting panel. 

▪ Edit the name of the camera in the Image Source Name text box (if 

needed) 

 

▪ Select the webcam from the list of image sources displayed in the Select 

Image Source dropdown menu. 

http://www.panlab.com/


 

 

 

Page 59 

Record-IT! Media Manual • Publication MAN-SOFT RECORD-IT MEDIA REV 08 • www.panlab.com ©2024 Panlab 

 

▪ Edit the available webcam parameters (here Frame Size and Frame Rate), 

if needed. Then click on the Accept button to exit. 

 

▪ The camera information is then displayed in the Image Sources - Settings 

table. 

 

4.2.2. Add a USB digital camera image source 

▪ Click on the  button to open the Image Source Setting panel. 

▪ Edit the name of the camera in the Image Source Name text box (if 

needed). 

 

▪ Select the Digital Camera image source from the list of image sources 

displayed in the Select Image Source dropdown menu. 
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Note: For the Basler USB 3.0 digital camera, the name of the camera has a different 
structure. For example: “GigE Vision pu280-544(40308285)” 

▪ Edit the available parameters (here Frame Size, Frame Rate, and other 

Parameters), if needed.  

 

It is important to set a frame rate optimal for the video recording process 
based on present system performance. You MUST follow the steps 
described in chapter 2.5.3.2 to set the camera ID and calculate the optimal 
frame rate for each camera connected to the system. Refer to Tables 1 and 
2 to adjust the optimal frame rate based on the number of cameras 
selected. 

If the selected frame rate is greater than the calculated optimal value, 
problems may occur with the recorded video (performance issues, 
incoherent video file duration…). 

Please be advised that not all image sources provide the possibility to 

specify different frame sizes. In that case the panel will not show the frame 

size section. 

In many image source devices choosing a bigger image size will result in a 

lower frame rate. Even if a higher frame rate is selected, the frame rate is 

always limited by the performance of the image source and the computer 

system in which it is running. This may cause the tracking and/or video 

recording to be performed with a lower frame rate than the one configured. 
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TIS Digital Cameras have the binning disabled. Thus, changing the 

resolution from 1280x960 to 640x480 will not reduce the frame size but 

will just reduce the region of interest. 

 

▪ In case of a Digital USB 3.0 camera set with Pylon Viewer (Basler, see 

chapter 2.5.2.2) be sure to select the User Set defined in Pylon Viewer. 

 

Also, in the bottom part of the panel, the info about the camera will be 
shown: 

 

▪ In case of a Digital USB 2.0 camera set with IDS Camera Manager (see 

chapter 2.5.3.2) in the Parameters section, make sure that the Load 

parameters from camera settings option is checked. 

 

▪ Then click on the Accept button to exit. 

▪ The camera information is then displayed on the Image Source table. 

 

 

4.2.3. Add a Basic Network Camera image source (non-ONVIF) 

▪ Click on the  button to open the Image Source Setting panel. 

▪ Edit the name of the camera in the Image Source Name text box (if 

needed). 
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▪ Select the Basic Network Camera option from the list of image sources 

displayed in the Select Image Source dropdown menu. 

 

▪ Enter the URL. 

o Different types of cameras have different URL formats, so you 

will need to find the RTSP URL that is correct for your camera 

stream. Contact the camera supplier/manufacturer to get the 

correct RTSP URL address for your camera model. 

o Uncheck the “RTSP – TCP – Transport Protocol” option if the IP 

Camera does not allow RTSP-TCP-Transport. 

o Enter User Name/Password (if present) of the IP camera. 

 

Click on the Detect network camera button to detect it. 

Once detected, the Quality text box of the Device properties will be filled, and the 
image of the camera should be displayed in the preview panel. 

▪ The camera information is then displayed on the Image Source table. 
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4.2.4. Add an ONVIF Network Camera image source 

▪ Click on the  button to open the Image Source Setting panel. 

▪ Edit the name of the camera in the Image Source Name text box (if 

needed). 

 

▪ Select the ONVIF Network Camera option from the list of image sources 

displayed in the Select Image Source dropdown menu. 

 

▪ Click on the Search button of the IP address to have access to the 

available list of installed ONVIF cameras, select one of the cameras and 

then click on the Accept button. 
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The corresponding IP Address and Port in the Select Image Source section as well 
as the devices properties will be filled with the corresponding information. 

 

Click on the Edit Quality button  to select a different quality setting and then 

refresh the device properties by clicking on the Refresh button . Refer to Table 
3 to adjust the optimal frame rate based on the number of cameras selected. 

▪ Click on the Accept button to close the Image Source Settings panel. 

▪ The camera information is then displayed on the Image Source table.  

http://www.panlab.com/


 

 

 

Page 65 

Record-IT! Media Manual • Publication MAN-SOFT RECORD-IT MEDIA REV 08 • www.panlab.com ©2024 Panlab 

4.2.5. Add an analogic camera image source 

▪ Click on the  button to open the Image Source Setting panel. 

▪ Edit the name of the camera in the Image Source Name text box (if 

needed). 

 

▪ Select the corresponding Analog-Digital Converter option from the list of 

image sources displayed in the Select Image Source dropdown menu. 

 

 

▪ Edit the available parameters (here Frame size, Frame Rate and Filters), 

if needed. Then click on the Accept button to exit. 

 

Deinterlacing filter 

The images provided by most analogic cameras are interlaced. Interlaced video is 
a technique to double the perceived frame rate of a video display without 
consuming extra bandwidth. The interlaced signal contains two fields of a video 
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frame captured at two different times. Although this enhances motion perception 
to the viewer, this technique produces images which are not optimal for video 
tracking, especially in case the subject is moving fast horizontally across the image. 
This means that interlaced images may greatly affect the outcome in global activity 
analysis. 

The following is an example of a normal image compared to an interlaced image: 

  
Normal image   Interlaced Image 

Activating the deinterlacing filter, the interlaced images come back to normal 
images. 

Aspect Ratio filter 

The Aspect Ratio Adjustment should be applied only when the CONVANAUSB is 
used to connect a HDCVI camera. With a HDCVI camera there is light distortion of 
the image, which stretches the image vertically. Review the document “User’s 
Quick Guide_HDCVI Cameras” provided with the camera for additional 
information about this setting. 

These filters require the installation of FFDSHOW codec. The FFDSHOW installer is 
automatically launched when RECORD-IT! MEDIA is installed, and no action is 
required by the user. 

▪ The camera information is then displayed on the Image Source table. 

 

4.2.6. Add a Camera Simulator – Computer Generated image 

source 

▪ Click on the  button to open the Image Source Setting panel. 

▪ Edit the name of the camera in the Image Source Name text box (if 

needed). 
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▪ Select the Camera Simulator – Computer Generated option from the list 

of image sources displayed in the Select Image Source dropdown menu. 

 

▪ Edit the available image source parameters (here Frame Rate), if needed. 

Then click on the Accept button to exit. 

 

 

▪ The camera information is then displayed on the Image Source table. 

 

4.2.7. Add a Camera Simulator – Recorded Subject image source 

▪ Click on the  button to open the Image Source Setting panel. 

▪ Edit the name of the camera in the Image Source Name text box (if 

needed). 
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▪ Select the Camera Simulator – Recorded Subject from the list of image 

sources displayed in the Select Image Source dropdown menu. 

 

• Edit the available image source parameters (here Frame Rate), if 

needed. Then click on the Accept button to exit. 

 

▪ The camera information is then displayed in the Image Source table 

 

4.2.8. Add a Camera Simulator – Custom Recorded Video image 

source 

▪ Click on the  button to open the Image Source Setting panel. 

▪ Edit the name of the camera in the Image Source Name text box (if 

needed). 
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▪ Select the Camera Simulator – Custom Recorded Video from the list of 

image sources displayed in the Select Image Source dropdown menu. 

 

▪ Select the Video File to be used as image source, Open it and then click 

on the Accept button. 

 

 

▪ The camera information is then displayed on the Image Source table. 
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4.3. Image Source display 

Once the Image Source – Settings panel is closed, the live view of all the cameras 
are displayed in the Recording main panel.  

 

 

4.3.1. Image source view action bar 

 

The camera view action bar allows the user to choose the way the images of the 
image source will be displayed in the Recording main panel. 

 
Single image source view 

 
Four image sources view 

 
All image sources view 

 
Show/Hide image source name 

 
Show/Hide image source status 
panel 

 
Camera selector for the single image 
source view 

 
Camera selector for viewing the 
image source 1 to 4 

 
Camera selector for viewing the 
image source 5 to 8 
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4.3.2. Single image source view 

 

Click on the  button, then use the individual Image source selectors 

to switch from one image source to another one. 

 

4.3.3. Four image sources view 

Click on the  button, then use the 2X2 Image source selectors  or  
to switch from a set of 4 image sources to the other set of 4 image sources. 
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4.3.4. Eight image sources view 

Click on the  button to diplay the view of all available cameras. 
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4.3.5. Show/Hide the Image source names 

Click on the  button to show or hide the name of each image source. 

 

 

 

4.3.6. Show/Hide the Image Source Status panel 

The Image Source Status panel provides a summary view of the recording status 
of all the available image sources/cameras. 

Click on the  button to show or hide the Status of each image source. 
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An Image Source Status table is displayed with the following content: 

Status Status of the image source: 

Recording 

 Not recording 

Camera name Name of the camera defined in the Recording Settings 

Rec. Time Current recording time elapsed from the start of the 
recording process. Expressed in HH:MM:SS.oo. 

Rec. Progress Recording progress 

• Free running text is shown when the Free 

running option is set from the Recording 

Settings panel. 

•  time progression bar is 

shown when a preset duration is selected 

from the Recording Settings panel. 

Preset Duration Recording duration set from the Recording Settings 
panel. 

• n/a (does not apply) is shown when the Free 

running option is set from the Recording 

Settings panel. 

• The preset time is shown when a preset 

duration is set from the Recording Settings 

panel. Expressed in HH:MM:SS. 

Video File Name Name of the recorded digital video file. 
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4.4. Storage 

 

 

4.4.1. Videos Folder 

The Videos Folder shows the Video file path set to save the recorded video file. 

 

This path can be changed from the Recording main panel by clicking on the Browse 
Folder button and selecting the new folder selected for saving the recorded video 
files. 

 

 

 

The Open Videos Folder  button can be used to open the videos folder and 
access the content. 

 

 

4.4.2. Available Space 

The Available Space section shows a bar indicating the approximate remaining 
hard drive space available for recording video files. 
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4.5. Recording Settings 

The Recording Settings main button leads to the Recording Settings Editor. 

In the Recording Settings Editor, the user can define: 

• The output name of the recorded video digital files 

• The duration of the recording process 

 

 

The settings applied in the Recording Settings section correspond to the image 
source selected in the left Image Sources panel. If the user selects another Image 
Source, the Recording Setting panel updates content accordingly. 

 

4.5.1. Output Video File Name Settings 

Define the name of the video file recorded from the selected image source in the 
Output Video File Name Settings section and then check the result in the Output 
Video File Name Example section. 

4.5.1.1. Use the Camera name as prefix 

▪ Select the Camera name as prefix option. 
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4.5.1.2. Enter user defined text as prefix 

▪ Select the User defined text as prefix option. 

▪ Enter the text to be used as prefix (“Subject 1” in the example below) 

 

4.5.1.3. Add the date to the video file name 

▪ Select the Append start recording date (format yyymmdd) option. 

 

4.5.1.4. Add the time to the video file name 

▪ Select the Append start recording time (format hhmmss, 24h) option. 

 

 

4.5.2. Recording Duration Settings 

RECORD-IT! MEDIA provides a specific panel for managing the recording start/stop 
conditions and duration. 

4.5.2.1. Maximum Estimated Time 

RECORD-IT! MEDIA provides information about the maximum available recording 
space and time. These values depend on several factors, but the following are the 
most important: 

• Number of cameras recording at the same time. 

• Image quality (pixel & frame rate) of each recording camera. 
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• Free space of the hard disk where video files are stored. 

The program will estimate the maximum recording duration based on the amount 
of available space detected on the hard drive. Estimates are provided for the total 
available recording time as well as for the time available to each individual camera 
feed. The latter is calculated by dividing the total available time by the number of 
cameras. 

 

Note that the actual recording limit may be different than the value estimated. It 
may also vary suddenly if conditions change. Examples include changes in video 
activity (e.g. if the animal begins sleeping, causing a reduction of activity in the 
video image) or changes to computer resources due to concurrent use of other 
programs. 

When the recording process reaches the maximum available space, RECORD-IT! 
MEDIA will automatically stop recording and save the video files from all cameras 
to prevent taking up all the hard disk space. 

The estimated time available will be automatically recalculated if additional 
cameras start recording. Please check the estimated time periodically to avoid 
losing the data. 

 

4.5.2.2. Free running 

When the Free Running option is selected, the recording start and stop times are 
controlled manually by the user. 
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4.5.2.3. Preset Duration 

When the Preset Duration option is selected, the user starts the recording process 
manually, and recording stops automatically when the preset duration time has 
elapsed. 

 

 

4.5.3. Apply All option 

Click on the Apply to all images sources button to apply the same settings to all 
image sources. All settings but the camera name and user defined prefix will apply 
when selecting this option.  

 

A message will appear for confirmation. 
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4.6. Recording Start/Stop 

It is highly recommended that Windows Updates are disabled, 
otherwise this can cause serious problems to the ongoing recording 
sessions. To see if they are enabled, go to Control Panel->Windows 
Update. 

The recording process can be started from two locations on the main Recording 
panel: 

▪ Individually from each camera player. 

▪ Simultaneously from the Recording section of the main menu. 

4.6.1. Individual start/stop 

Click on the  button to individually start recording from each image source. 

 

 

• The time panel color will switch from grey  to red 

 and show the current recording time. 

• The red RECORD button will switch to the green Stop  button. 
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• A time progression bar with a cursor  will be 

displayed, showing the progress of the recording time.  

• The Show Live Image button is activated by default. Click on this 

button  to pause the on-screen image refresh process. The cursor 

may then be moved to visualize the images currently recorded.   

• Click on the  button to access to the Image Source properties. Below 

are the properties available from a connected webcam: 

 

The settings of the camera may be changed, applied, and then saved in the project 
file.  

When no properties are available, clicking on the Settings button has no effect. 

4.6.2. Simultaneous Start All/Stop All button 

A Start All/Stop All button is available from the Recording section of the main 
menu. 
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5. PLAYER 

Select the Player main menu to access the Player section. 

 

5.1. Open a video file 

5.1.1. Open a video file through the Media List 

5.1.1.1. Media File Selector 

Select the Media List menu to open the Media File Selector 

 

Select a video and then click on the Accept button to open it into the RECORD-IT! 
MEDIA Player. 

Once selected, the name of the video file will be shown in the Selected Video File 
text box. 
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The Media File Selector table provides the following information: 

▪ Status: 

The Status column indicates the link status of the video. 

o : linked videos icon - RECORD-IT! MEDIA can find the video 
on the computer and open it through the Recorded Videos 
Media table. 

o : unlinked videos icon - the linked video cannot be found (the 
file has been deleted in the computer or the file name has been 
changed). 

▪ Date Time 

Date/Time of the video file recording. 

▪ Camera Nr. 

Index number of the camera (Internal RECORD-IT! MEDIA index number from the 
8 possibilities). 

▪ Camera Name 

▪ Name of the Image source defined in the Image Source Settings panel. 

▪ Record ID 

Internal ID code provided by RECORD-IT! MEDIA. This code is unique for each video 
file. 

▪ File Name 

▪ Name of the recorded video file defined in the Recording Settings panel. 

▪ File Path 

Path to the Recorded video recording folder. 

▪ Frame Rate 

Frame rate of the recorded video expressed in frame per seconds (fps). 

▪ Frame size 

Frame size of the recorded video expressed in pixels. 
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5.1.1.2. Rearrange the information in the Medias List table 

The information in the Medias table can be sorted by columns to find a specific 
video more easily. 

▪ Select the title of one column to sort the information of this column by 

alphabetical order.  

 

▪ Click again on the same column title to sort the information of this column 
in reverse alphabetical order.  

 

▪ While holding down Shift on the keyboard, click on the title of the second 

column to add a second level of rearrangement.  or . 

 

▪ The content can also be searched through a user-defined filter. 

▪ Click on title of one column, click on the right arrow to display 
the dropdown menu and select the Text Filter option.  

 

▪ Enter the text used to filter the information and then click on the 
OK button. 
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▪ Select the Clear Filter option to remove the filter and recover the 
full content of the table. 

 

5.1.1.3. Find and Relink Videos 

A video can be unlinked for 2 reasons: (1) the name of the file has been changed 
or (2) the video file has been deleted from the computer. 

The unlinked videos  can be relinked by using the Find and Relink Videos… 
button. 
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▪ Select a Folder in the Target Directory Video Folder section. The 
Scan Option section indicates the number of Missing Videos 
(here 3 videos are missing). 

 

▪ Click on the Start Search button to scan the folder. The Scan 
Results section will indicate the number of Videos Found in the 
folder as well as the number of videos matching the missing 
videos (Matching Videos). In the following example, only 1 of the 
missing videos has been retrieved. The 2 other videos are still 
missing (they have been deleted or moved to another folder…). 

 

▪ Click on the Relink button to relink the video file. 
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5.1.2. Open a video file through the File Browser 

Select the File Browser menu to open the Select a digital video file window. 

 

Select a video and then click on the Open button to open it into the RECORD-IT! 
MEDIA Player. 

Once selected, the name of the video file will be shown in the Selected Video File 
text box. 
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5.2. Video file information 

Information about the video file is displayed in the Video Info main menu section. 

 

Use the right scroll down tool to view the complete video information. This 
information can be copied and pasted to another program, such as Word. See 
example of copied/pasted information below.  

File Name: Image Source 1_20191121_161324.mkv 

File Format: Matroska / WebM 

File Size: 8 MB 

File Date: 21/11/2019 

Frame Size: 854 x 480 

Frame Rate: 5.000 FPS 

Video Bitrate: 0 bps 

Video Codec: h264(H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10) 

Audio Info n/a 

 

5.3. Player controls 

RECORD-IT! MEDIA Player has onscreen controls like those found on standard 
video digital players. 
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Timeline with play-head cursor 

 

Time (HH:MM.SS,00) 

 
Play/Pause buttons 

 
Fast-Rewind/Fast-Forward buttons (each 10 frames 
steps) 

 
Frame-by-frame Rewind/Forward buttons 

 

Player speed settings 

 

Total duration of the video file 

 

Stop button 

Use the controls to play, pause, rewind, fast-forward, jump to a specific 
frame/time, adjust the speed, or end. 

To go to a specific point in the video file, drag the play-head (in the timeline). 

To step through frame-by-frame, you may also first click the play-head and then 
click on the Right or Left Arrow keys on your keyboard. 
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5.4. Resize the player 

The Player can be resized by dragging the lower-right corner or the lateral sides of 
the window (a white arrow will appear when the cursor hovers over the resize 
white arrow tool). 

 

The proportions of the image of the video will not be affected by the resize 
operation. 

5.5. Close a video file 

Use the Close File menu to close the video file and empty the RECORD-IT! MEDIA 
player. 
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6. HELP 

Select the Help main menu to access the Help main panel. 

 

 

▪ If you have questions about the application’s usage, select the User 

Manual menu option or click on the F1 key to open this document. 

 

▪ For further information, select the About menu option. 

The first information panel provides important information for technical support 
purposes: 

o Software Serial Number 

o Operating system/computer information 
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▪ Click on the More Info. Button to view our contact information. 
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7. INTEGRATE RECORD-IT! MEDIA IN A 3RD PARTY 

APPLICATION 

RECORD-IT! MEDIA can be used by another application (3rd party system) to 
provide video recording capacity and to facilitate data synchronization. 

A communication protocol for RECORD-IT! MEDIA can be developed using an API 
(Application Programming Interface). The API allows for external programs to send 
commands to and receive responses from RECORD-IT! MEDIA. 

Find below the list of commands available from RECORD-IT! MEDIA:  

• Load a configuration project file, 

• List configured cameras, 

• Start recording using the camera "camera name",  

• Stop recording from the camera "camera name",  

• Play a video file indicating its "file path", starting at position “seconds” 
(time stamp). 

In order to use RECORD-IT! MEDIA as a third-party application with your software, 
please refer to the technical specifications listed in the document present in the 
USB key license. Contact us for more information. 
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8. CONTACT INFORMATION 

 

We are available to help you with your questions and concerns. Should you hit a 
roadblock or need some additional training, please feel free to visit the HBIO 
Behavioral Support Center at https://support.behavior.hbiosci.com to find articles 
and helpful information in our knowledge base or submit a ticket. We are happy 
to help! 

PANLAB 

Carrer de l’Energía 112 

08940 – Cornellà de Llobregat 

Barcelona - SPAIN 

 

Technical Support 

Email: support@panlab.com 

 

 

http://www.panlab.com/
https://support.behavior.hbiosci.com/
mailto:support@panlab.com
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